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Revision History 

Revision Date Author Description of Changes 

1.0 12/05/2017 Peter Punzalan Manual Created for No Card List version, changes 

on Access Level configuration 

1.1 05/28/2018 Peter Punzalan Updated software version and added features. 

1.2 9/20/2018 Peter Punzalan Updated Software version and fix some bugs 

1.3 04/13/2020 Peter Punzalan Updated Software and added some new feature 

1.4 09/15/2020 Peter Punzalan Updated Software and added features 

1.5 04/22/2022 Peter Punzalan Updated Software and SQL version 

1.6 10/27/2022 Peter Punzalan Added Aperio Lock Integration 

2.1 12/13/2023 Peter Punzalan Added new OSDP Controllers 

Chapter 1 Introduction 

1.1 WATCHNET ACCESS Overview 

WATCHNET ACCESS is a Global manufacturer and supplier of Integrated Security Solutions such as Access Control, 

CCTV, and Intrusion with basic Building Management. WATCHNET ACCESS meets the tough end-user demands for 

safety, security and user friendliness. WatchNET has a strong global presence providing its systems to more than 40 

countries. For more information please visit our web site at www.watchnetaccess.com 

1.2 Software Overview 

The WatchNET Access Security Management Software comprises of a suite that covers the complete range required 

by Access Control Professionals. The software is modular and ranges from the standard single user package to multi-

user systems. Additional modules are available which include CCTV and Intrusion. 

1.3 Features 

The WatchNET Access Security Management Software is available in multiple languages and also has the option of 

installing MS Access or SQL Server. During the installation process the user can select the language as well as the 

database.  

Note: Please Install MS SQL software supplied with the software on the CD first. 

1.4 Web & FTP Sites 

Although software is supplied on a CD at the time of purchase periodic enhancements and bug fixes renders the 

software out of date within a short period of time. To make it easier for the installer up to date software is located on 

http://www.watchnetinc.com/
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the WATCHNET ACCESS FTP site which is accessible through our web site. 

1.5 Getting Started 

• Connect the all-necessary cables and power up the controller (see Hardware Manual). 

• Setup the controller and any converter addresses (see Hardware Manual). 

• Install and Configure MS SQL Server Database  

• Load the WATCHNET ACCESS INTEGRATED SECURITY SYSTEMS v1.1 software and then setup the following: 

• Setup the communication port  

• Search for the Panels  

• Setup the parameters of each door including Time Table  

• Setup Departments and Sub Departments  

• Add a Wiegand Format if not already added  

• Add Personnel and configure their cards and assign Access Level. 

• Flash the Personnel card to a reader of a door which he has the Access Level to enter. The Lock relay should 

operate and a Valid Card event will appear in the Events Monitor. If Invalid Card or Invalid Time/Door event 

appears please check the Access Level. 

1.6 Computer Requirements 

The WatchNET Access Security Management Software is designed to run on a Microsoft Windows platform. While 

the software is designed to run on Windows 7 and Windows 8 it will also run on Windows XP although the 

performance may be reduced. The following is the minimum computer requirement: 

 Minimum 3rd Generation Intel® Core™ i5-3340s processor (6M Cache, up to 3.3 GHz) Equivalent or higher 

 Free 500 GB Hard Disk space 

 RAM: 8GB RAM 

 VGA: 1024 x 768 pixels 

 DVR ROM Drive 

 Video Card - Intel® HD Integrated Graphics or Equivalent 

 Free Serial and USB Port (For license dongle or RS485 connection if needed) 

Windows Server 2008, 2012, 2016, 2019 , Windows 7, Windows 10 or Windows 11 
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Chapter 2 Main Operating Window 

2.1 Logon 

The message box explains that if using more than 8 doors you require access license to run the software, 

for standard version just click OK

 

 

Logon with the default Administrator user or click the arrow to the right of the User name to logon with a different 

user. The default the password is watchnet.  

 

Note that any additional users must be configured first, see in Chapter 6. 
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Once logged in, the main window will display. This window has a Menu Bar, Shortcut Menu; it shows the Authorized 

User, i.e. the company that the software is licensed to and the Current User. 

  

2.2 Menu Bar 

The Menu Bar allows access to the entire program via a series of Sub-Menus. The Main Menu consists of the 

following: 

 

2.3 Tool Bar 

 

The Tool Bar or Icon Bar contains the most common icons they are as follows: 

✓ Controller Configuration 

✓ Door Configuration 

✓ DVR Configuration 

✓ Channel Mapping 

Real time events 

Tree 

Menu Bar 

Shortcut Menu 

Map Page 

Camera Live 

view 

Company/Name 

License registered 

to 

Current user 

logged in 

Card Events 
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✓ WAB-X-FCK (Fingerprint Reader) 

✓ WFD (Face Recognition) 

✓ Departments 

✓ Security Groups 

✓ Personnel List 

✓ Visitor List 

✓ Access Level 

✓ Pre-set Level 

✓ Holiday Type Setup 

✓ Event Alerts 

✓ Flow Control 

✓ Multi-Site Setup 
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Chapter 3 Management Menu 

 

3.1 Clients Manager 

Clients manager menu allows the admin user to add or delete a client access (Client Software). 

3.2 User Manager 

The WatchNET Access Security Management Software allows multiple users (software operators) simultaneously and 

can give each user a different level of access. Only the System Manager (Administrator) can add or delete the users 

and modify/add/delete user’s permissions. It is important that the installer set up individual users according to their 

rights and privileges. The password length can be up to 20 digits and includes any keyboard characters.  

Note: that initially there is only a single user called Administrator with an Administrator Permission 

Settings. 
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Before creating a User we will need to create a Group that the user belongs to or use one of the 5 default groups: 

Administrators, Access Control Users, Accounts Managers, Guarders, and Guests.  

Note: Every User needs to belong to a Group.  

The Group grants the privileges to the kind of operations, functions, and the configurations the User will be able to 

perform in the system. When defining the User the system will specify to which panels/doors and departments/sub 

departments the privileges inherited from the Group will apply.  

 

Adding a Group  

Click or select Group and click New icon on top to create new group.
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Enter details for the new Group and click on the Create button.  

 

 

Editing a Group 

When group is created, select or highlight the group name and click Properties icon on top. 

 

 

 

 

• General – you can add user to this group 
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• Group Right – this tab allows you to modify the access rights of the group on the software, check and 

select which is suitable for the group 
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Adding a User 

To create a user, select or highlight User on the tree and click New icon, input all the information needed and click 

create 

 

Editing a User  

To modify a user, select or highlight and click Properties icon on top
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General – this tab allows you to modify the full name and description 

Belongs to – on this tab you can assign the user to a group 

Department Rights – you can select the department rights on this tab 

Site – select the site for this user to access 

Access Rights – allows you to select the components or doors that the user have access to 

Intrusion Rights – allows you to select the intrusion zones for alarm system 

CCTV Rights – allows you to select the cameras, DVR that user should have access to 

Fingerprint Reader – also allows the user to select the fingerprint reader user has access to 

Face Device – select face device that the user has access to 

Security Group – select the security group the user has access to 

Map Rights – Select the map you want the user to have access to 

Event Alert Rights – Select the type of event the user to have access to 

Language – select which language the user has access to change 

 

Deleting a Group or a User - To delete a user or group, select the user or group you want to delete and click 

Delete icon on top. 

 

Select the option and click OK 

 

3.3 Change Password 

Right click the user and select Setting Password to change the password 

 

Input the new password and click OK 
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Change Password 

The Administrator account’s password can be change on the change password settings. 

 

3.4 Departments 

Select Management on the main menu bar and then select Departments from the sub-menu or you can click on the 

 Department button. This will allow for additional departments or sub departments to be set up and an 

existing department to be deleted or to be edited.  
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Departments may also be further divided into Sub Departments if required. 

Departments and Sub Departments assist us to set structure and group personnel together. 

When clicking New Department a sister Department will be created. When clicking New Sub Department a 

Sub (child) Department will be created. It can also be used in case the system should be used for a multi company 

installation site. 

In such case each company will be a department and each company department will be a Sub Department. 

The software enables the user to begin the configuration from the general setup menu. This way the setup is 

performed structurally and easily. Before adding new Personnel to the system we can design the company structure 

first and then assign the Personnel to Departments. 

By Gender - The configuration performed in the 4 tabs will apply to personnel by gender. 

If Set Sub Department Order is clicked, the Window of Figure 6-17 will be opened. 
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You can adjust the order of the department which you selected by clicking the button up and down, Top and Bottom. 

 

 

Time and Attendance Policy 

Defining the Time and Attendance policy for the Department/Sub Department is done on the right hand side of 

form. Each Department/Sub Department can have its own policy.  

 

Regular work time - including IN (or Work IN), OUT (or Work OUT) and Day Off. 

http://www.watchnetinc.com/
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IN Time is based on the time Personnel are coming to the office (the time the card event was created). The system 

will also calculate Late In (if he/she comes late) or Early In (if he/she comes to the office early). 

Out Time is the time that the Personnel have left the office. This will be used to calculate Early Out or Late Out 

similar to Early In and Late IN Time based on the policy. 

Day Off will be used to determine when the employee is entitled to a day off. 

Late In/Early Out Allowance - The number of minutes allowed for coming IN late or going OUT early. The system will 

not report that the Personnel came late to the office if he arrives at 08:05 while the Work IN time is 08:00 and Late IN 

allowed is 15 minutes.  

The Personnel will also be considered late only if he/she came after 08:15. The same rule applies for Early Out 

Allowance as well. 

 

First In/Last Out will be rounded - Check this option if you would like to round the IN time if the minutes between in 

time and Work In are less than Late In Allowance. For example if Personnel arrive at the office between 07:45 to 

08:15 there In Time of that day will be reported as 08:00 if the Allowance is 15 minutes. The rounding will be done 

similarly for Last Out. 

 

Apply Over time for Over – The system will report that a Personnel has worked over time on a day if his/her Over 

Time of that day is bigger than X minutes then the Over Time will not be reported. The method to calculate over time 

is configured in the Overtime section. If 30 minutes is set and the Personnel over time is only 20 minutes on that day 

then the over time will not be counted. 

 

Cut-off point/Lunch break – This period will be deducted from the time the Personnel have worked during the day.  

Overtime Policy 

In the Overtime Policy we can define if over time will be considered as Late Out only by the extra time the Personnel 

spent in the office or by adding the extra time (Late Out + Early In) of arriving at the office before the Regular In 

time. The third option is the total working hours minus the Regular Working hours. 

Total Work Hours 

This can be defined as last Out – First In – Lunch Break. In This way we ignore all In/Out during the working day. 

Alternatively, it can be defined as the intervals between the In/Out minus the Lunch Break. We can use this option if 

we would like to deduct the time the Personnel stayed Out of the office during the working day. 

Variable Definition: 

• Last Out: the last time the Personnel flashes his card at any of the system readers during a certain 

day. This time will be considered as the time the Personnel leaves the office. 
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• First IN: the first time the Personnel flashes his card at any of the system readers during a certain day. 

This time will be considered as the time the Personnel arrives in the office. 

• Work IN: the IN time which is defined in Regular Working Time. 

• Work OUT: The Out time which is defined in Regular Working Time. 

 

3.5 Group Management 

Group Management allows you to create new group for personnel. 

3.6 Site Management 

Site Management allows you to add manage or delete different sites.  

 

3.7 Change Database 

This setting allows you to change the database or connect the server to a different server as client 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

23  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

 

Select MS SQL data base 

If you do not see the name of the SQL Server (PEDRO-PC\SQLEXPRESS) then copy and paste the name of the server 

from the Microsoft SQL Server Management Studio Express. Use sa and watchnet as the User Name and Password 

and select WatchnetAccess as the database from the pull down menu. Once this done click on the Test Connection 

button to test connection. 
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If the installation was configured correctly then you will see the above screen. 

3.8 Glossary 

Glossary allows you to modify the fields you want to display on the Basic Information tab of the Personal 

Information, you can hide, show or edit the field name that shows up on the tab. 
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Enabling the check box for the Birthday field will enable that field on the Basic Information tab 

 

 

3.9 System Management 
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• Uniqueness Inspect – Below option to disable duplicate or field cannot be empty 

o Personnel Code 

o First Name 

o Last Name 

o ID Number 

 

Events View/Alert Range 

A user can define the range of events and alerts presented on the WatchNET Access software which is Events Monitor, 

Multi-Site View monitor and the Controller Manager 

 

Events Monitor Range:  

Display Localhost hardware events – Display events only on local server 

Display these hardware that current operator has right events – Display events only for operator that has access 

rights to the software 

Display system all events – Display all events for local server and client software  
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Events Alerts Range:  

Alert local host hardware events -Only Alerts from panels which are connected to the PC which is running 

WatchNET Access Software will be displayed. 

Alert this hardware that current operator has right event - Displays Alerts only from panels which are connected to 

the PC and that the user (see User Accounts, e.g. Administrator) has the privileges to monitor. 

Alert system all events - Alert information from all panels will be displayed in the WatchNET Access Software 

including Server panels and the Client panels. 

 

Cards/Area Changed Personnel Range: 

Display these personnel that current operator has right - Displays the personnel’s cards and area’s events. 

Display all personnel - Displays all the cards and area changed events. 

  

 

 

 

 

 

 

Screen Saver 

To start up Screen Saver click the Screen Saver tab and check the Enable checkbox and then set up the time. 
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Photo Viewer 

To set up the photo display times click on the Photo Viewer tab and then check the Photo Display Time(s) checkbox 

and then adjust the time. You can adjust the Font by clicking the Font… button. 
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Area Viewer 

The area viewer is for Anti-passback feature and setup the area such as inside area and outside area, can also select a 

camera where the anti-passback door is configured. 

 
Area Setup: enables you to count who is in an area and to display these details on a large screen monitor.  

• Scroll text: sends a scrolling message to a large screen monitor. 

• Channel: displays the designated camera on the Window. 

Note: this has been designed for large screen monitor and so on a standard monitor the resolution may 

not be appropriate 

 

Card Validity - To set up card validity of personnel when card is inactive and shows inactive personnel from the 
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software 

  

Other Options – Other options you can disable/enable such as Automatically run when OS is started, ask 

username/password when opening hardware status and others.  
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3.10 Holiday Settings 

Configure and rename holidays for the year 

 

3.11 Daylight Savings Time 

To set up Daylight Savings Time select Management and then Daylight-Saving Time. 

 Use the drop-down menus of Time 1 to set the month then the day that the daylight savings time begins and the 

number of minutes that the time will be advanced.  

Note: Upper setting only works on Ver.45 controllers, “New Daylight-Saving Time” setting works only on Ver.03 

controller 
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3.12 Import Active Directory 

You can import personnel names from an active directory using this feature  

 

 

3.13 Connect WatchNET Active Directory Database 

To connect to the Active Directory select Management and then Connect WatchNET Active Directory. 

 

In the Import Personnel From WatchNET AD select the Database Link tab. Select the server name from the Select or 

enter a server name (PC Name) from the drop down menu. 

Note: if the drop-down menu is empty then click on the Refresh button. 

Next select Use a specific user name and password from the Enter information to log on to the MS SQL Server 

option. Type sa for User Name: and watchnet for password: 

Next select the WatchnetAccess database from the drop down menu of the Select the MS SQL Database name on 
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the MS SQL Server: option. 

To finish configuring the Active Directory setup click on the Test Connection button.  

    

The Connection tested successfully message appears. Click OK to close the message box.  

 

To select AD importing options click on the Options tab. 

Click the “Import” button for the first import. 

 

 

 

Note: If the database “WatchNETAD” table does not exist when you click the import button then the 

software will auto create the table in the database. 
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WatchNETAD table structure: 

CREATE TABLE [WatchNetAD] ( 

 [AutoID] [int] IDENTITY (1, 1) NOT NULL , 

 [ID] [nvarchar] (50) NULL , 

 [State] [smallint] NULL , 

 [FirstName] [nvarchar] (20) NULL , 

 [LastName] [nvarchar] (20) NULL , 

 [DisplayName] [nvarchar] (50) NULL , 

 [Office] [nvarchar] (50) NULL , 

 [TelephoneNumber] [nvarchar] (20) NULL , 

 [CardNumber] [varchar] (20) NULL  

) ON [PRIMARY] 

ALTER TABLE [WatchNetAD] WITH NOCHECK ADD  

 CONSTRAINT [PK_WatchNetAD] PRIMARY KEY CLUSTERED  

 ( 

  [AutoID] 

 )  ON [PRIMARY] 

 

Chapter 4 Setup Menu 

4.1 Hardware 

4.1.1 Controller Configuration 

To start to search for the controllers click on Setup -> Controller Configuration.  

Or you can click Controller Configuration icon -  
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Searching for Controllers 

The WatchNET Access controller’s architecture allows for one quick step searching without the need for manually 

configuring panels.  

To begin searching for the panels click on the Search button and then the Search and Upload Controller window will 

display. 

  

You can search the WatchNET Access panels either through a COM port or through TCP/IP.  

Searching panels over a COM port – Is used when the controller is connected directly to the Server through the 

RS232 connectors or USB port if a RS232-USB converter is used. This also applies when a group of panels are 

connected together through RS485 communication or when a RS485 to RS232 converter is used to connect to the 

serial port of the Server. If you are not sure to which COM Port your panels are connected please go to the Windows 
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Control Panel -> System -> Hardware -> Device Manager -> Ports (COM & LPT). 

 

Click on Search and the connected panels will be listed.  

  

Check the boxes of the ID column of the panels you would like to connect to. 

Click Save and then Close. The panels will be listed in the Controller Configuration dialog box. 
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Searching Panels over an IP address - WatchNET Access provide panels with built in fully integrated TCP/IP module. 

Unlike other Access Control Software’s in the market which are using external converter and Virtual IP address. 

WatchNET Access panels use real TCP/IP communication and real IP address.  

The setup of the IP address can be done automatically. 

⚫ Search – Searches for controller in the network 

⚫ Manual Configure – Manually configures the IP address by setting each of the parameters. 

⚫ Auto Configure – Software will configure the IP address automatically. 

⚫ Wizard… - The wizard will collect the information necessary to configure the controller module 

⚫ Reset - Restarts the controller module. 

⚫ Connect Controller – Connects the selected controller(s) which works under the TCP Server mode. 

⚫ Connect All Panels – Connects the entire controllers which work under the TCP Server mode. 

⚫ Exit – Exits the dialog box. 

 

 

 

 

 

On the controller PCB board near the blinking communication LEDs, 

there is a DIP Switch (S2) with DIP1 and DIP2. DIP1 is Write Protect 

for the IP address; please make sure DIP1 is ON before configuring 

the IP address. DIP2 sets a fixed IP (factory Default IP) of 10.1.1.10 

regardless of the status of DIP1. Please make sure DIP2 is OFF. 
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To start searching for panels click on the Search button. All Mac addresses will be listed. Double click on the one you 

would like to configure and the TCP/IP Setting window display. 

⚫ Mac Address: A unique identifier attached to the network adapter (the TCP/IP module). 

⚫ Name: Controller name which can be a maximum of 30 alpha-numeric characters. 

⚫ IP Address: The IP address of the controller. 

⚫ Mask: The Subnet Mask of the Network  

⚫ Gateway: The Default Gateway  

⚫ Port: TCP/IP port which can be between 1024 to 65535. The default value is 8000.  

⚫ Work Mode: If you select TCP Client then the controller will connect the host which is specified by the Host IP 

otherwise the controller will wait for the client’s connection. 

⚫ Host IP: The IP address of the PC which is connected to the panels through the TCP/IP network. The Host PC will 

receive all panels’ card events. 

⚫ Server Port: Can be between 1024 to 65535. The default value of 8000.  
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Click OK to finish and log message should come up saying `parameter successfully` 

  

Close TCP/IP Setting 
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Check the panels you would like to add and click Save and then Close. The panels have been searched and recognized 

by WatchNET Access Software. 

 

 

Adding a Controller 

Alternatively to searching for the panels automatically the user can add a controller by clicking on the Add button on 

the Controller Configuration form. The Add Controller. Click on the drop down menu to select the Controller Type 

Model then enter a Name for the controller. The controller name can be a maximum of 30 alpha-numeric characters. 

Next enter the COM Port or the IP Address and Port of the controller that is being added.  
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Note: the controller hardware DIP switches (1-8) must be configured before panels are added.  

 

 

Deleting a Controller 

To delete a controller highlight the controller to be deleted and then click on the Delete button.  

 

Click OK to confirm deletion. 
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Editing a Controller 

Editing the selected controller parameters (Figure 7-17) 

 

Refresh a Controller 

To refresh the displayed status of all the panels click on the Refresh button. 

Download a Configuration 

To download a current WatchNET Access Software database setting and configuration from the Server to a specific 

controller, highlight the controller then click on the Download button. 
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Download Configuration to All (Local) 

To download the current database from the Server to all the panels, click on the Download Configuration to All 

(Local) button. 

Site Management 

To open the Site Management window click on the Site Management Button from the Controller Configuration 

window. 

 

The Site Management window appears. 

 

In the Site Management window, you can add the name of projects or installations. 

4.1.2 TCP/IP Setting - This menu is same on controller configuration. 

4.1.3 Search Controller - This menu is same on controller configuration. 

4.1.4 Door Configuration - To start configuring the doors, select Setup -> Hardware and then Doors Configuration 

from the main menu or you can click on the Doors icon .  

The Door Configuration window consists of 5 tabs: Parameters, Door Status Schedule, Door Access Schedule, 

Personnel Access Level and Channel Mapping, also on door configuration you can setup a flow control, event driver, 

wiegand format, UDP Broadcast and bank card code. 
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By Inputs - By Inputs configuration allows you to modify the flow control on the specific control such as open 

and closing condition 

  

Event Driver - Event driver is where you can configure a flow control using events. 

 

Wiegand Format - Wiegand format allows you to modify the bit format of reading from a single control or let it 
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follow the system settings. 

Note: Do not change settings unless needed. 

 

UDP Broadcast - Broadcast settings are configuration for global flow control that does not require the server to be 

running to execute. 

 

Bank Card Code – Settings for bank code feature. 

 

Click any door to show this menu 

Parameters - This is where any general function related to a specific door is configured. To start configuring a 
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door, first highlight the door from the list of panels and doors on the left-hand side.  Once the specific door has 

been highlighted then the items for that door can be configured. 

This includes: 

• Door Parameters 

Door Code Door code names 

Door Name: E.g. Front Door 

Door Type:  An IN reader only or an IN/OUT reader. (This field will be available depending on the panel 

type) 

Door Sensor:  Normally Open or Normally Closed (Can also be disabled if not in used) 

Sensor Anti-Shake (MS): Allows you to modify the sensor’s time when to beep when event happen 

Exit button:  Normally Open or Normally Closed 

Lock Open Time(S):  The relay unlocks time which is normally 5 seconds. 

Handicap Card:  Enable or Disable, when enabled door will be open for a long period of time when 

handicap card is swiped 

Handicap Time(S):  door will stay open when handicap card is scanned depending on time setup 

Lock Monitor Time(S):  The time before an alarm which is normally 30 seconds. The Lock Monitor Time is used to 

make sure that the door was not left propped opened for a long period of time. 

Read Card Mode: can choose from two options: Single card or multiple cards which is needed for opening 

the door. 

Multi Card:  the number of valid cards that need to be flashed before the door can be opened. 

PIN Required:  If enabled, card and pin have to be presented on the keypad reader to open door 

Max. 3 wrong PIN:  If enabled and an incorrect PIN is entered 3 times then the software will delete the access 

level of the card. 

Duress PIN: A fixed 4-digit PIN to be used when under duress. 

Super PIN:  When enabled the door can be opened with a PIN only by entering *12345678# where 

12345678 is the Super PIN. 

Armed Code: A code that arms or activates a link on a keypad reader. 

Disarmed Code:  A code for disarming/deactivating a link on the keypad reader.  

Armed Flow Control:  Activates the programed links. 

Double Card: Enable/Disable Double Swiped for Boss/Master Card  
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Reader Parameters - are also setup from within the Parameters window as follows: 

LED Polarity:  Changes standby mode color from blue or green. 

Buzzer Control:  To test the buzzer of a reader  

Buzzer Alarm: To enable or disable event alarms 

Reading Delay:  The shortest time interval between reading 2 different cards. 

Keypad Delay:  The shortest time interval between 2 digits being entered at a keypad. 

Wiegand Reader Type: can change from WatchNET reader, HID IClass or short interval readers 

Wiegand Pulse Interval: manage the pulse interval of sending data from reader to controller 

Wiegand Pulse Width: manage the pulse width on how long the reader sent the data to the controller 

As a card issuer  : To set the reader as a card enroller from the personnel list 

Anti-Pass Back 

Area APB:  Select Enable for Area Anti Pass back. 

Exit Area:  Exit Area for Anti Pass back. 

Entry Area:  Entry Area for Anti Pass back. 

Area Name:  Select this button to give an area an alpha numeric name. 

The door parameters can be copied from one door to another providing the doors are of the same type (IN door to 

an IN door). Highlight the door that you want to copy and click on the Copy button and highlight the door that you 

want to paste the parameters to and then click Paste. YOU will notice that there are two Set All buttons on the 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

48  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

window. The one on the right-hand side of the window is used to set all the doors (Door 1) of the same type of 

controllers on the network to the same settings. The Set All button on the left side will copy the settings of all the 

tabs to all the doors (Door 1) of the same type of controllers. If you have copied the settings of door 1 then all door 

1s will be set. The same has to be repeated for door 2 and so on from the first controller. 

Door Status Schedule 

This is where the schedules for a specific door are configured. There are 15 available time tables per door. Double 

click on a Time Table or click on the Edit Status button to launch the Door Status Time Set window. On this window 

the actual status for the doors can be configured. Enter the Start Time and then click on the arrow next to the Entry 

Status label to select a status.   

Options are: 

Open from 1st Card: Door opens as per the schedule depending on first valid card. If the fist  

                              valid card is before the scheduled door open time then door closes after  

                              access granted. If no valid card is presented on the door when it is set to  

                              open from 1st card then the door stays closed. When a first valid card is   

                              presented then the door opens and stays open as per schedule. 

Normal: Door is always close and only opens when valid card is presented 

Sleep: The system is effectively asleep and will not read a valid card. 

Always Open: The door is always open (unlocked). 

Always Closed: The door is always closed (locked) and can only be unlocked with a Master Card. 

Card + PIN: Card and PIN required. 

APB:      Anti Pass back. 

Open/Closed:           Door status changes on valid card. First valid card will open door and it stays                    

                                    open until next valid card is presented to close  

Twin Card Mode:    Twin Cards have to be swiped both to open door 

Group Card Mode (GCM): group card has to be presented to open door 
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To configure the Door Status Schedule, check the days of the week to apply the chosen status for. The H1-H7 boxes 

refer to the seven types of holidays that can be configured and the T1-T2 boxes refer to the two types of temporary 

dates that can be configured.  

Note: GCM Mode is only available in Ver. 03 controllers 

Door Access Schedule 

The Door Access Time Table sets the Time Tables for Door Access and is configured similarly to the Door Status Time 

Table. At the Door Access Time Table we also specify the End Time. 

Each door can have up to 15 different Time Schedules while each Time Schedule can have up to 7 different Time 

Zones. In the Time Zone section is where the days and time period for the door access are configured. Different Time 

Zones can have different days and hours. 
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Personnel Access Level 

Display the Personnel who have access to certain door. 

 

For Example, when Access is granted on Door 1 the controller can turn on Auxiliary Output 1 for a specified amount 

of time. 
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Channel Mapping 

Allows for the integration with DVR’s which allows for the taking of snapshots and the recording of live video when 

an event occurs. 

 

To start configuring Channel Mapping click on the Channel Mapping tab and click the Add button. 
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Select the Controller, Door and Event from the Door section. Then select the DVR and Channel from the Channel 

section. The final step is to check on the Captured, Recorded and Camera Popup.   

 

With this configuration when Door 1(002) is forced open then Camera 1 of the Demo DVR will take a snap shot and 

also record a Pre and Post event recording for 10 seconds. Also the Camera will pop up on the Video window of the 

screen. 

 

  
 

Note: In order for the pop ups to be displayed the Auto Switchover and the Auto Play check boxes have to 

be checked, and to see the Popup right click on card events and select “Personal Photo Viewer” 
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If you click the Add more button from the Channel Mapping tab you can add more events as the event source.   

 

 

Any event will trigger the action. 
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Delete the channel mapping by clicking the Delete button and then OK.  

 

 

To edit the mapping select the corresponding record and then click the Edit button. 
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4.1.5 T & A – this can configure parameters, LCD display, Alarm clock settings. 

Note: this feature can only be used in WAC-1D2T-Micro. 

• Parameters - Can modify below configuration

 

• LCD Display - Can modify Display message on LCD display of the 1D2T Micro 
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Alarm Clock - Setup alarm or buzzer for a specific period of time using auxiliary output 

 

4.1.6 Standalone Controller Configuration – Currently not supported. 

4.1.7 Controller Components - To configure the Control Components select Setup -> Hardware menu and then 

Controller Configuration. This will open the Controller Components List. Controller Component consists of 

(Doors, Locks, Door Sensors, Exit buttons, Aux Inputs, Aux Outputs, and Readers). These components can be 

renamed by highlighting the Component and by right clicking and then selecting Rename or alternatively 

clicking on the Rename button 

 

Other functions are available depending upon the type of Components. For example highlighting on a door and then 

right clicking will launch a menu that allows the user to force open the door manually. Right clicking on a Door sensor 
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allows the door status to be changed.  

 

The Follow Schedule  button downloads the schedules from the WAC software on the Server to the 

panels. For example, if the schedules were set with a Server that has been replaced and the schedules have been 

updated on the new Server then clicking on the Follow Schedule will download the new schedules to the panels. 

4.1.8 Preset Components Status - Pre-set configuration allows the user to set a temporary components 
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schedule 

 

 

 

4.1.9 Disable/Enable Doors – Enable/disable the door on certain date or time.  
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4.1.10 Prosys Intrusion  

• Panel Configuration - Click search or add to add a prosys panel. 

 

• Search Panel - Click search to find a prosys panel on the network 

 

• Panel Components - To configure the prosys components. 

4.1.11 Prosys Plus Intrusion – Adding and searching is the same process from prosys intrusion 

4.1.12 DSC Intrusion – Adding and searching is the same process from prosys intrusion 

4.1.13 PIMA Intrusion – Adding and searching is the same process from prosys intrusions 
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4.1.14 DVR Configuration - to start to search for DVR’s select Setup -> Hardware -> DVR Configuration. 

 

Click on the Search button to launch the Search DVR window. 

 

Search 

To search for DVR’s click on Local Network to set the IP range.  

  

Once the IP range is set click on the Search button to start the search. 
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Check the DVR’s that you want to add and then click the Save button to add the selected DVR’s. 

 

 

Adding DVR’s manually 

Click the Add button to launch the ADD CCTV DVR window. 
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Enter the DVR information and then click the OK button to add the DVR. 

Delete 

Click the Delete button to delete the selected DVR. 
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Click OK to delete selected DVR. 

Edit 

Click the Edit button the edit the selected DVR. 

 

Change Host 

Click the Change Host button to change the DVR host. 

4.1.15 Search DVR - Refer to Search. 

4.1.16 DVR Channel - The DVR Channels List displays the entire channel mapping information. Click Setup-

>Hardware->DVR Channels. 
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4.1.17 Channel to Doors/Zones Mapping – See sections Channel Mapping 

4.1.18 Fingerprint Reader - Click Setup->Hardware->Fingerprint Reader to open configuration. 

Note: Before opening configuration make sure fingerprint parameters are set, sample below is showing 

WAB-P-FCKS configuration. 
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4.1.19 Face Recognition - Click Setup->Hardware then Face Recognition to add face recognition device.  

Note: Before adding a face recognition device make sure the face device parameters are set 

  

4.1.20 LED Screen - Click Setup->Hardware then LED Screen to add LED Screen, this option is used to set up an 
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external, serial or TCP/IP connected LED display screen. Click Add to add LED screen. 

  

4.2 Cards 

4.2.1 Access Security Groups  

Access Security Groups is where you can create different group of access levels, either per departments or just per 

personnel 

To start adding cards click on Setup -> Cards -> Access Security Groups 
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By default, a 24 Hours access group is configured on the system 

Note: A group must be created depending on the access level of the department of the personnel. 

4.2.2 Personnel List 

The Personnel List is where the main user information is entered. Select Personnel List  from the main menu 

bar or choose Personnel List from the Setup -> Card sub-menu. All the individual Personnel information can be 

found in this window. Personnel can be added and modified or deleted. From the Personnel List window Personnel 

records can also be exported into Excel, Text, Html or MS-Word file. 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

68  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

 

Adding a Personnel 

Click on the Add a Personnel button to launch the Personnel Information window. Enter the card user’s information. 

Basic Information – input first name last name and other information needed 

 

Note: The first and the Department are mandatory fields and must be filled out in order to proceed to 
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the Card tab. 

There are three options for obtaining a photo image. 

1. The folder icon  adds a saved photo image from the C:\Program Files (x86)\WatchNET\WatchNET 

Access Integrated Security Systems\Photos path.  

2. The camera icon  adds a photo image taken from a digital camera. 

3. The scanner icon  adds a scanned photo image taken from a scanner. 

Click on the Card tab to add card information. Check the Use Access Card option to activate the card. 

4. Card – Card tab is used to setup card parameters of personnel 

 

 

This option is 

used for 

CARD+PIN or PIN 

Only on keypad 

readers and 

valid only for 

V40.** and 

V45.** 

Controllers 

Pin Only option 

is only valid for 

V.03.** 

Controllers Press 

“*PIN# to open 

door 
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Use Access Card - must be checked to activate card 

Card Info: 

Card No.  - input card number (sample is decimal format) 

Vice Cards  - enable to add multiple card for the personnel 

ID card Custom ID - additional ID number 

Expiry Date  - setup an expiry date for personnel or card 

Deactivate  - card will be automatically deactivated if not used on certain days selected 

Card Event Link to - to link another personnel to this user 

Retrieve card number from 

Desktop Reader- card number will automatically entered in Card No. when card is swiped in desktop 

reader 

Retrieve card number from 

System Reader- card number will automatically entered in Card No. when card is swiped in the 

reader 

Access Properties: 

Handicap Card- door will be open for longer period of time when card is swiped 

Manager Card: swipe card twice on a door to override door schedule to always open and swipe 

twice again to put back to schedule 

Boss/Master Card: can open door anytime and have access to all doors 

Temp Card: enable to assign the card as temporary card 

 

PIN: 

Pin ID- click automatically button to generate ID for pin 

PIN- Input PIN number for personnel 

 

Card Property for WAC-XDYE: 

Card Group: select a group number for card to follow GCM(group card mode) status 

Twin Card Select: card will be slave card and need to bind to any card when the Master-slave mode 

door status is enabled 

PIN Card: pin only can be used on keypad reader when card is lost or forgotten (only work with 

V03.** Controller) 
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• Access Level – Access level tab is where you select the door access for the card holder, there are two 

different ways of assigning access level: Security Groups/ Access Doors  

▪ Security Groups – To create access security group you can go to 4.2.1, once create you can 

select that access to the card holder 

 

▪ Access Doors – In Access Doors you can select single door and quickly assign access 

schedule for the card holder. 
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Click Add More to select a door, enable the door and select access schedule for that door, then click OK 

 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

73  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

 

 Lift Access Level – WatchNET Access Controllers also include Lift (Elevators) panels. WAE-016-ENC with built in 

TCP/IP communication along with WAE-E16-PCB expansion boards can handle up to 128 floors on each 

controller. 

These panels can work offline as well as with the WatchNET Access Software. 

WatchNET Access Software is intelligently integrating the WAE-016-ENC panel. The WAE-016-ENC configuration and 

programing is performed in a similar way to the rest of WatchNET Access panels. This creates efficiency in the setup 

and use of the panel. Since a Lift has a door we can treat this door like any other door and configure its Access Levels 

and Time Schedules. 

We can see that we set the Day Time Schedule for the Lift Controller (001). This means if the person flashes their 

card during this time schedule then they will be able to go to each one of the floors checked in the Lift Access Level 

tab. 

Direct Floor:  can only select one floor 

Visit Floor:  can select multiple floor that a personnel has access 

 

In the above example only Floors 1, 8 and 16 Floor Buttons will be activated.  

Note: Elevator Door must be enabled first to configure floor access levels 
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 T & A LCD Display - Can configure a display message keypad reader that has a Lcd display built in. 

 

Note: T & A Door must be enabled first to configure the LCD display. 

 PIN Enable – you can select which door has PIN required to access
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 PIN Enable for Lift – Enables Pin requires on door lift controller 

 

• Fingerprint – Enrols Fingerprint for personnel 

Enable Use Fingerprint to enrol fingerprint. 

 

Note: you can enroll using fingerprint reader or usb fingerprint enroller (WAB-P-USB) 
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Enroll fingerprint using fingerprint reader 

Click Enroll and wait the enroll message on the fingerprint reader  

Wait for 2 beeps and message on software. 

 
 

Enrol fingerprint using USB Fingerprint reader 

Installing USB Fingerprint Enroller 

Click on the  Windows Start button and click on Control Panel. Click on the button. 

Right click on FOH02CSC option . 
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Click on Browse my computer for driver software. 

 

 

Browse to the following folder path. C:\Program Files (x86)\WatchNET\WatchNET Access Integrated Security 

Systems\Drivers\BioUSB10 Enroller Driver(USB2.0)\64bit or 34bit. And click on the Next button. 

 

 

 

Click on the Install button. 
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Click on the Close button to complete the install. 

 

 

If properly installed you will see the above driver listed. 

In the Personal Information window click on the Fingerprint tab. 
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Note: Make sure that User Fingerprint is checked  

Click on the Enroll button to start to enroll fingerprints. 
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Click on Next to start the enrollment of Fingerprints. 

 

Select the finger to enroll. 

 

 

Place finger on sensor and follow the instructions. 
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Click on the Next button to enroll another fingerprint. 
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Click on Finish to complete Fingerprint enrollment. You will now see that the Delete and Verify buttons are enabled. 

• Face Info – enrol face screenshot for face reader 

 
 

 

4.2.3 Visitors List 

This option allows you to add/edit or delete a visitor’s card 

0 
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Click Add a Visitor 

• Basic Information – input basic information such as First Name, Last Name, Department and other information 

below 
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• Card – Input card number and select properties for the visitor’s card 

 

Card info: 

Card No.   - input card number 

ID card Custom ID  - additional or custom card number 

Expiration Time   - select expiration date for card 

Deactivate   - card will be deactivate when not in used 

Vice Cards   - click to add multiple cards 

PIN: 

PIN ID    - Unique PIN ID for each card (only works on Ver. 40.** and 45.**) 

PIN    - Pin number for card holder 

Access Properties: 

Handicap Card   - Door will stay open longer when handicap card is enabled 

Boss/Master Card  - have access to all doors and no anti-passback limitations 

Manager Card   - have access to all door base on the department assigned 

Temp Card   - when enable, card is only a temporary card and will expire 

Temp Card Valid Time: 

From/Expiration:  - select a date when the card will be valid 
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• Access level – select access level for card holder, can also refer to Access Level for Cards for detailed information 

• Fingerprint – Enrolls fingerprint for card holder, can also refer to Fingerprint for Cards for detailed information 

• Face Info – Enrolls Face screenshot for card holder, can also refer to Face Info for Cards for detailed information 

 

4.2.4 Access Level – Configure or create access level per departments or per personnel. 

 

 

4.2.5 Pre-set Personnel Access Level – Allows you to create a temporary access level to a card holder to a door 

for certain period of time. 
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Click Add to input access level, you can also click Add more  to add multiple personnel 

 

Note: Security group must be created first to create a temporary access level 
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4.2.6 Department Area Limit – Allows you to set a maximum entry on a specific door 

 

4.2.7 Emergency Card – Allows you to create emergency card when needed  

 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

88  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

4.2.8 Bank Card – Settings for Bank card feature 

4.3 Events Alerts –WatchNET Access Software provides powerful and flexible events handling and notification. Such 

as Access Event Alerts, Intrusion Event Alerts, and CCTV Event Alerts. For each type of events the user can assign a 

name, validation (by card number range, date and time) and background color. 

4.3.1 Access Event Alerts - From the menu bar, click Setup->Event Alerts->Access Event Alerts. This will open the 

Event Alerts window. Access Event Alerts allows user to add, delete or modify an event also user to trigger 

component by card events or controller component events. 

  

• Sound Hint – Sound hit tab allows user to add a tone for that specific event that will play on the server. 
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• Popup Hint – To select the popup location, icon and map popup. 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

90  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

 

• Real-time Events – real time events is configuration for the card events background color and fonts styles. 

 

• Send Event – Send event tab allows you to send the specific event to a different server as notification. 
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• Send Email – this tab allows you to configure an email notification for the specific event. 

 

• Send SMS – This tab is to configure the send text notification for the specific event. 
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• Print - This tab is to configure an automatic printing to a specific printer whenever this event occur. 
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• Lockdown – Lockdown tab lets you configure a component from the controller either open or close or follow 

schedule. 

 

 

4.3.2 Prosys Intrusion Event Alerts – From the menu bar, click Setup->Event Alerts->Prosys Intrusion Event 

Alerts. This will open the Event Alerts window. Prosys Intrusion Event Alerts allows user to add, delete or 

modify an event also user to trigger component by intrusion event and component events. 

 

4.3.3 Prosys Plus Intrusion Event Alerts – This is for the newer version of prosys plus intrusion 
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4.3.4 DSC Intrusion Event Alerts – Allows user to add, delete or modify an event, also user can trigger a 

component by intrusion event 

 

 

4.3.5 PIMA Intrusion Event Alerts – Allows user to add, delete or modify an event, also user can trigger a 

component by intrusion event  
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4.3.6 CCTV Event Alerts - Allows user to add, delete or modify an event, also user can trigger a component by 

intrusion event 

 

4.3.7 WFD 4 Event Alerts- Allows user to add, delete or modify an event for the face devices, also user can 

trigger a component by intrusion event 

 

 

4.4 Map 

WatchNET Access Software allows for multi-level mapping.  Up to four levels of maps can be created and displayed. 

Map levels include sites, buildings and floors. User can view all controller components (locks, sensors, exit buttons, 

inputs, and outputs). All maps and controller components are dynamic. Components graphical icons will change 

according to their physical status (i.e. lock was opened). 

Maps can be easily designed by dragging and dropping component icons on to the map. As mentioned in section 8.3 

Maps can Popup automatically and switch from Map X to Map Y if an alerted event took place on Maps’ Y controller 

component and Map was on Map X. 

 

4.4.1 Multi-Site Setup 

In the Multi-Site Setup is where the sites structure is configured. We define the sites and their names, the buildings in 

each site, the floors in each building and their maps (Figure 7-80). To start configuring Maps click on Setup -> Map -> 

Multi Site Setup. 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

96  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

  

Site   

The Site is the first level of Maps and first to be displayed and is assigned the Map 1 icon. To load a Global Map click 

on the Design Global Map button. Click on the Load button and navigate to the path where the Map is located. 
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New Map 

To start creating a new Map (Figure 7-81) click on the New Map button from the Multi Site Setup window.  

 

 
 

New:  Blank Canvas for creating a new map. 

Save: Saving the created map. 

Save As: Saving the created map under a different name and Pic ID (Picture ID). Pic ID is the unique identifier for 

maps. User can re-use the map name but not the Pic ID of the map. 

Rename: Changing the map name. 

Load: Loading a JPG picture to be the map usually a floor or blue print drawing. 

Remove: removing the map JPG file. 

Add: Adding controller components to the map. You can select multiple components by holding the Shift Key and 

clicking on the Down Arrow button or by holding the Ctrl key and selecting multiple components using the mouse. 

After adding the components they will be displayed on the left upper corner of the map (overlapping each other). 

You may drag each one for the desired position and then click Save to keep them in the new position.  

Delete: Select a component and click the Delete button to delete the component from the map. 

Properties: Viewing and changing the component properties.  

Close: Closes the Map Designer window. 

There are four types of components that can be added to the Map (Access, Intrusion, CCTV and Others). These 

components are grouped in tabs that are located on the left hand side of the Map Designer window. 
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Click on the Load  button to select a Map from the Map folder. The default path to the Map folder is 

C:\Program Files (x86)\WatchNET\WatchNET Access Integrated Security Systems\Maps. Select a Map and click OK. 

 

 

Next select the components to add to the Map by clicking on the corresponding tabs. Drag and Drop the component 
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onto the desired location on the Map. 

 

Click the Save As button to save the Map. 

 

Enter the Picture Name and click OK. 
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The new Map is now displayed on the Main window. 

4.4.2 Map Designer 

Shortcut menu to configure the map. 

4.4.3 Delete Map 

Delete a Map by selecting it from the list. 

4.4.4 Icon Library 

The Icon library offers a selection of different icons for the same component including different size (i.e. small lock 

icon, big lock icons etc.). This provides high flexibility for the user in respect to his map picture or blue print 

proportion.  
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• Add:  Adding an Icon by selecting a JPG picture and entering an Icon ID and Icon name. 

• Delete: Deleting an Icon. 

• Rename: Chaining Icons’ name. 

• Change Icon: Changing the Icon picture (JPG file). 

 

4.5 Flow Control  

4.5.1 Access Flow Control 

Flow Control allows for defining a logical conditioning such as If (Condition) Then (Action). 

AND, OR operands can be applied to create more complex conditions. 

There are 3 types of the Flow Control:  

1. Output Status Schedule 

2. By Inputs 

3. By Events 

4. By Global Flow Control. 

 

To launch the Flow Control window, click on Setup -> Flow Control -> Access Flow Control. 
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Output Status Schedule 

On this feature you can set the additional output relay to follow open/close schedule on a certain schedule 

By Inputs 

Flow Control by Inputs means the Flow Control is done according to the physical controller components (Locks, Exit 

Buttons, Door Sensors, and Aux Inputs/Outputs etc.). 

Condition can be created like the example below: 

If (Source1) AND (Source2) AND … (Source8) Then Activate (Relay); 

We do not have to use several Sources with AND. 

Flow Control allows the user to use the WatchNET Access system not only for Access Control application but also for 

any type of automated control like basic Building Management. 

With this we can also connect to a Fire Alarm System contact and command all doors to be opened automatically. 

Based on an external timer (sensor) we can turn off lights or air conditioning system in the building. 

For Example; Source (Aux Input 1 = Open) Output Action (Aux Output 2 = Open) and Action Mode: Back to Normal, 

this means that if the Aux input 1 is open, Aux Output 2 will be open as well and Action mode is set to Back to 

Normal if source is closed. 

  

 

By Events – Flow control by events allows you to open certain relays by using all different types of event from 
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the doors and relay inputs, it could be opened from first card, door forced open or invalid card. In example 

below, If the Door 1 is forced opened the Aux Output 1 will be open for 10 seconds and will close again after. 

  

Note: WatchNET Access Server will have to be online, closing the software will stop the global flow 

control conditions. 

Global Flow Control – Allows you to trigger an output from 1 controller to another controller 

 

For Example: If Door 1-Lock is open from Main Floor controller the Door 2-Lock from Second Floor will be 
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opened as well and will go Back to Normal when door 1 lock is closed. 

Armed Linkage 

WatchNET Access software enables events to be controlled through the keypad reader by entering specific codes. Up 

to four linkages is possible per reader. In order to use this function, we first need to program a link through flow 

control. Let’s assume a scenario where we have a Motion Sensor connected to Auxiliary Input 1 and we need an 

Alarm on Auxiliary Output 1 only when Auxiliary Input 1 is in Armed condition. 

To achieve this, we need to program a flow control and enable this as Armed Linkage 1 as indicated below: 

 

Once this is done then we need to activate this link through Keypad card readers on this controller. Let’s now move to 

Door Parameters. In the door parameters choose the reader which has the keypad and in the door parameters tab 

set the Arm Code and Disarm Code as indicated below. This code is then set to Armed Linkage 1 or whatever was 

programmed to achieve what we need. 
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We can test this function by first right clicking on Armed Linkage 1 and then turning the Auxiliary Input 1 ON. The 

Auxiliary Output 1 will turn ON. When Armed Linkage is disarmed then turning Aux Input 1 will not turn Aux Output 1 

ON. If this works then the Armed Linkage is right. 

To use this function through a reader, first flash a valid card that has access to that door at that time and enter the 

appropriate codes to Arm and Disarm the linkage. 

 

4.6 UPD Broadcast – UDP Broadcast is use to enable the flow control using RS485 connection, when 

this feature is enabled the software does not have to be online all the time to execute the flow 

control. 
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4.7 Wiegand Format 

The method by which WatchNET Access panels can be configured to read multiple formats simultaneously is set up 

from the Wiegand Format window. By default, the system comes with four pre-defined formats. These are 26-bit 

&34-bit. Any format between 24 and 72 bits can be configured from this window. If the system is required to read a 

card with a number of bits outside the two listed above then these formats need to be configured before a card will 

be able to be read by the system.  

 

To edit a format first highlight the format and click on the Edit button. The Wiegand Format setup window will appear 

(Figure 7-95. The Use Wiegand XX Bits Format box must be checked if you wish the system to recognize this format 

Setting Rules: 

⚫ For Wiegand format setting you should enable the format of the card you are using and disable all others. 

⚫ If the correct Wiegand format is not configured then you may get a wrong card number. 

NOTE: THIS SECTION IS MEANT FOR ADVANCED USERS ONLY. PLEASE DO NOT MODIFY ANYTHING IN THIS 

SECTION UNLESS NEEDED. ANY ERRORS COULD AFFECT THE ABILITY OF THE READERS TO READ THE 

CARDS PROPERLY. 
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The example below is a for 34 Bits format. Initially leave the two Parity boxes blank and proceed to the Data Format 

section at the bottom of the window. At the Data Format section enter the valid bits you want to read as a 1’s and 

any bits that you do not want to be read enter as a 0. If you only know the number of bits on a card but do not know 

where the parity bits are located then as a temporary measure enable all the card bits, i.e. for 34 bit, place a 1 under 

bits 0 to 33. At this stage close the window and flash a card with the same format that has been entered. If the card 

reads and creates a card event in the Events Monitor then the system is recognizing the card format.  

Note: this is not the card number but it is just the number generated by all of the bits that have a 1 

allocated to them.  

Return to the Wiegand Format window to continue. If nothing happens when a card is flashed and the system does 

not recognize the card format then the card is not the same format that has been edited. 

  

Once the system is actually reading the card format the next step will be to set the Data Format box so that the 

system ignores any Parity bits. This is for the purpose of calculating the card number. Most formats but not all also 

have a Parity bit at the start of the card data and another at the end. While these bits appear on the card and form 

part of the bit structure and number of bits they do not contribute to the card number. The Data Format box now 

needs to be edited and a 0 placed under any bits that are Parity bits. In the following example the 1st (bit 0) and the 
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last (bit 33) are both Parity bits so a 0 is placed under bits 0 and 33. Click OK then flash the card at a valid reader. The 

number that appears now is the card number. In the following example the standard MIFARE 34-bit card has been 

used. The standard MIFARE card has 32 cardholder bits plus 2 x parity bits and one at each end thus giving a total of 

34 bits.  

Note: some readers such as Indala for example add a one-byte checksum (8 bits) onto the MIFARE card 

number and send the data out as 40 bits. 

The next step is to enter the Parity data into the Parity 1 and Parity 2 Windows. Although the system will work 

without this information the parity bits protects the data being received by the system and ensure that only valid 

data is received. In the 34-bit example the parity bits are bit 0 for parity bit 1 and bit 33 for parity bit 2. Enter a 0 for 

Parity No 1 and enter a 33 for Parity No 2. If there are more than 2 parity bits then ignore them. 

Parity can be either None, Odd or Even and this must be known. Parity Bits check that the data is not corrupted and 

will normally be calculated over a specific number of bits. In the 34-bit example the Parity No 1 (Bit 0) is Odd Parity 

calculated over bits 1-16. Parity No 2 (Bit 33) is Even Parity calculated over bits 17-32. The card manufacturer will 

normally supply the total number of bits the location of parity, whether parity is None, Odd or Even and the bits 

over which the parity is calculated. 

Parity is very important and if both parties are set to none then you might get a wrong card number. Please ask the 

reader supplier to give you a correct structure of Wiegand output. 

Different readers have different parities. But most of HID readers are the same. The output of HID reader is 

depending on the card. 

Note: there are many different methods for numbering the bits. The WatchNET Access software and 

panels count from the right-hand side at bit 0. Some systems start counting at bit 1.  

 

4.8 Special Date 

Temp Date 

Clicking on the Temporary Date sub-menu item will open the Temporary Date Setup Window. Two sets of Temporary 

Dates can be configured. The default date is the current date. Temporary dates will be cancelled after 7 days. 
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Holiday Type Setup  

Click on Setup -> Special Date -> Holiday Type Setup to launch the Holiday Setup window. To select a holiday just 

double click on the date and the color will turn Red to indicate that this date is now a holiday. To cancel a previously 

selected holiday just double click the red holiday and it will return to the default color. There are seven holiday 

groups available from the tabs at the bottom of the Window and each group can have 365 holidays. 
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4.9 Communication Configuration 

In order for the software to communicate with the controller or converter the communication parameters need to be 

configured. This is done in the Communication Configuration window. 

 

Server Tab 

The Server name is the name or IP of the PC which runs the WatchNET Access Software. For PCs which are running 

WatchNET Access Software as Clients the Server PC name or IP should be set in this field. 

The Server Port is 47100 by default and should only be changed if the same port is being used by another software. 

In this case Server Port will need to be changed to avoid conflicts. 
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Communication Tab 

The Communication tab is shown below. 

  

Network Delay Time: 

The maximum delay time allowed between the controller and the Host PC. If the Network Delay will be for more than 

200 milliseconds then the WatchNET Access Software will consider the controller Offline.  

User needs to adjust the value according the quality of the LAN in use.  

⚫ If panels are connected by unstable LAN then Delay Time should be more than 50 Milliseconds, e.g. 200 

Milliseconds. 

⚫ If panels are connected through Wireless LAN then Delay Time should be more than 50 Milliseconds e.g. 200 

Milliseconds. 

⚫ If panels are connected over WAN then Delay Time should be more than 50 Milliseconds e.g. 1,000 Milliseconds. 

 

Get transaction one by one (RS486 Bus): 

The software will receive the transactions (events) from each controller one at a time.  It is not recommended to 
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leave the check box unchecked as transactions from controller to the WatchNET Access Software might be lost.  

Send Data to controller after transactions: 

If this option is selected then the WatchNET Access Software first gets transactions and then sends the next data 

packet. It is not recommended to select this option when the system is connected to many panels. Checking this 

option under these conditions would cause a massive amount of CPU usage. 

Get component status with component events: 

If this option is selected then the software will first retrieve component events from controller and then it will check 

for events and if the events include a change in component status then the system will retrieve the component 

status. The software will finally refresh the component status thus saving system resources. If you uncheck the 

checkbox then the software will retrieve the component status actively. 

Write communication log:  

When checked all the communication events will be logged in Communication.txt log file. The file is in the WATCHNET 

ACCESS INTEGRATED SECURITY SYSTEMS folder. 

Broadcast public information:  

When checked the public information (All the information which is common to all panels e.g. Card information, 

Holidays, Summer/Winter time etc.) will be sent to all panels at the same time. The public information will be sent 

only 1 time and if there is communication/network failure then some information might be lost and may not reach to 

the panels. If not checked then the software will send the public information to the panels one by one. If 

communication fails then it will send it again automatically up to 10 times. It’s is recommended not to check the 

check box. 

 

WatchNET Access Software will broadcast the information below to all the panels which are connected to the Host 

PC. Otherwise the WatchNET Access Software will download the information to each controller one by one. 

 

⚫ Card List 

⚫ Holidays 

⚫ Temporary date 

⚫ Summer/Winter Time 

⚫ Wiegand Formats 

⚫ Saved Event 

 

 

Area will be changed by valid event (without sensor, PC should be on line):   

This option is checked if there are no door sensors and Anti-Pass Back (APB) function is used. The APB function by 

default is changing the Personnel area based on a Valid Card event + Door Sensor Open status. If the user checks this 

option then the area will change based on a Valid Card event only.   
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Note: For APB to work the server must be online. 

All the panels share temp date and holiday: 

When checked all the panels will share the same group of temp date and holiday. Otherwise you should set up the 

temp date and holiday for different controller.  

Host IP Address: The IP address of the PC which is connected to the TCP/IP panels. Click on the  button to set the 

correct Host IP address. 

Listening Port: The PC port is used for the TCP/IP communication. The default is 8000. 

After setting the communication parameters click on OK to apply the new settings.  

 

Clock Adjustment Tab 

At the Clock Adjustment tab, clicking the Clock Adjustment button allows the data and time to be synced. It will sync 

the PC time to the panels and DVRs. 
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Desktop Reader & Card Number Format Tab 

Users can change the number format shown in card events. 

 
Reader Setup: User can select from COM port or USB connection for desktop reader. 

Reader Type: This refers to the output type of the desktop reader. The options include HEX, ASCII, WG232, WAR-S08-

232, and WAR-S08-ENC. 

Card Number Length: option to select WG26 or WG34, has to match the Wiegand setting of the reader 

Card Number Format: Displays the card number format. 

Decimal: WatchNET Access Software will display the card number as HEX format for example 008959551.  

Wiegand: The software will display the card number as Wiegand format for example 136, 46655 (The same card with 

0008959551 in Decimal format). 

HEX: WAC1 will display the card number as HEX format for example 88863F (The same card with 0008959551 in 

Decimal format). 
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DVR Tab 

Use this tab to configure DVR’s settings. 

  

⚫ DVR Series: Select the type or model depending on the DVR/NVR you wanted to connect 

⚫ Connect Timeout 

The DVR will reconnect on the time out period set. 

⚫ Real Play Configuration 

Can choose from Sub Stream or Main Stream when viewing the camera live. 

⚫ Playback Configuration 

Playback Feature includes Throw no frame, throw one B frame and Throw two B frame. Network Feature includes 

shortest delay mode, the best real time, less latency, more fluency, and the best fluency. 

⚫ DVR Alarm Upload Type 
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There are two types of update type which is “Listen” and “Setup Alarm Channel” that allows you to select which 

type you prefer. 

⚫ DVR Alarm Upload Type 

This allows you to connect also your DVR Alarm if you have one setup. 

⚫ DVR Alarm Listen Type 

Configure the DVR’s IP and port. 

⚫ Capture Picture Quality 

Allows you to select the quality of the picture for snapshots on events 

⚫ Real-time capture time (in seconds) – Description on the right side 
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Intrusion Tab – Intrusion tab allows you to modify the time out session for the intrusion panel. 

 

Fingerprint Tab - There are 5 integrated Fingerprint Readers. Select the Fingerprint Reader that is installed and 
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click OK. 
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Face Recognition Tab - To Configure the Face Device Host IP must be set for the Face device and click OK 
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Times Canteen Tab - This feature must be enabled to use the Times Canteen Feature 

 

Send Events Packets 

This allows to send or export the events into a different server, to configure enter the “Server name/IP 
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address” & “Server listening Port” of another server you wish to send the events 

 

4.10 Area Name 

When using the Anti-Pass back feature then we can change the names of the different areas. Clicking Rename will 

allow us to do so. 
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4.11 Saved Events 

Saved Events have three types of System Event: Access, Intrusion and CCTV 

 

This window allows the user to select or deselect any events that are not required to be saved in the memory of 

controller. By default all events are saved but there may be occasions when certain events are not required to be 

saved. 
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System Events - Access 
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System Events – Prosys 

 

System Events – DSC – Same as Prosys 

System Events – PIMA - Same as Prosys 
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System Events - CCTV 

 

4.12 Car Parking 

Control a parking lot by counting the number of cars entering and leaving while limiting the maximum number. Once 

the maximum number is reached an Output will be activated. This feature requires WatchNET Access Software run all 

the time. 
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The example above shows that cars will be entered the parking lot through Door 1(001) of Controller 001. Maximum 

number of cars allowed is 5 while currently there are 2 cars in the parking lot. The cars are leaving through Door 

2(001) of Controller 001. If the Car Park has reached the max capacity then you have a choice of outputs that can be 

activated. This can turn on a red traffic light and/or close the Main Entrance gate. 

 

Chapter 5 Monitor 
This section allows the user to choose what they want on the window. This could vary from operator to operator 

depending on the role they play in the organizations security needs. Clicking on the Access Tree will launch a tab on 

the left hand side of the window. Clicking on the tree again will make it disappear. If the operator just needs to access 

it temporarily then all he has to do is to move the mouse over the tab and the tree will slide in to the view. If he 

needs to lock it for viewing it permanently then he should click on the pin which locks it in place. 
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5.1 Boot Platform 

The Boot Platform allows you to display and open shortcut items, see below image 

 

5.2 Access Tree 

The Access Tree displays all the panels their components on the system. You can operate the devices connected to 

the panel by right clicking on it and performing the required actions. If the controller is offline then you will see a red 

X mark.  

5.3 Intrusion Tree 

Same concepts as the Access Tree, this displays all the intrusion panels and their components such as Zone, 

Partitions, and status of each.  

5.4 CCTV Tree 

CCTV Tree displays all the DVR and the Camera that are connected to the system. 

5.5 Map Tree 

Allows you to open and close Map Tree on the left side 

5.6 Map Page 

If you want to design a map then refer to 8.4. Double Click on the map name in the map tree to launch the map 

page window. 
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Main: Click the button to go to the Main map. 

Return: Click the button to go to the prior map. 

Acknowledge: If the WatchNET Access Software receives alert event then the button flashes to remind you to 

acknowledge the event. 

Auto Switch over: When checked the map will switch automatically when an event relating to the map occurs. 

 

5.7 Events 

The Events Monitor presents all the Events divided into 11 categories: Alert Events, Card Events, Face Recognition 

Records, Bank Card Events, Controller Operation Events, Area Changed Events, Intrusion Events, Intrusion System 

Status, CCTV Events, Canteen Records and System Log. The Area Changed events are created only if we activate the 

Anti-Pass back. We can see all events information. Double clicking on an event will open the relevant Personnel 

Information as described in Section 8.2.2. It allows the user to change the information or even enroll a new card and 

personnel to WatchNET Access Software.  

  

5.8 Intrusion Virt keypad – This will display a virtual DSC Keypad for arming and disarming the alarm 
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system from the software. 

 

 

5.9 Photo Viewer 

This shows the details for the card holder with the phone. For example their badge picture as well as a snapshot from 

a camera and has 6 different views. 

 

• 1 Photo Viewer 

This will open Single Photo Viewer window as indicated in the picture below and displays the Photo and credential 

of the card holder, also shows a snapshots of the event if a camera is connected 
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• 2 Photo Viewer  

This opens 2 photo viewers, two transactions. 

 

 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

132  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

• 4 Photo Viewer A 

This opens 4 photos at the same time. 

 

• 4 Photo Viewer B 

This will open Multi-Photo Viewer B window as indicated in the picture below. The latest entry is displayed in the 

left hand side slot picture area whereas the previous ones move to the right hand side. 
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• In/Out Photo Viewer 

This opens the view for area where it the personnel coming in and out of a building. 

 

• Face Recognition Viewer 

This will open a new window that monitors the face recognition device events. 
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5.10 Camera 1 

Camera 1 allows you to view one camera only on the live view  

5.11 Camera 2 

Camera 2 allows you to view one camera only on the live view  

5.12 Camera Playback 1 

Opens/close the camera playback window on the right side. 

5.13 Camera Playback 2 

Opens/close the camera playback window on the right side. 

5.14 Park Counter 

Click Monitor-> Park Counter and this will open the Park Counter window. See Figure 8-6 

   

5.15 Area Viewer 

This real time event viewer shows the record count for a door or building and displays how many personnel are 

inside or outside. 
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5.16 Camera or Grid (Area Viewer) – If enabled, instead of grid view on area viewer it will display photos 

 

5.17 Card Validity Display 

This real time event viewer allows you to monitor a card that is expiring or expired. 

 

5.18 Camera View 

Click Monitor-> Camera Viewer and the will CCTV Camera Preview window open.  
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5.19 Clients 

Shows the WatchNET Access Software Clients which are currently connected to WatchNET Access Software Server.  

 

 

 

 

 

 
 

Channel List. The 

number of Cameras will 

be managed by the 

License of the software 
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Chapter 6 Report 
All type of reports listed below 

 

6.1 All Cards Events 

Generate reports with all the cards events. 
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In the View menu we can use a Filter to search for certain records and we can export the report to an MS-Excel file 

and we can show it in a preview mode so it will be suitable for printing. 

Records can be Filtered or Located. 

Clicking on the Filter in View menu brings up the Filter window. To locate a record click on the field that you wish to 

search by and then enter a starting date and an ending date then click OK. Any records that exist conforming with 

your search criteria will be listed. 
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A record can be searched for a particular value. Click on Locate in View menu and the Locate window will display. 

Clicking on the drop down box under the Fields label will list the fields on which a search can be made. Enter your 

data and check the required boxes then click First to find the 1st entry conforming to the data then Next to find any 

subsequent matches.  
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6.2 Quick Query Card Events 

Run and view card events via departments or via door card events 

 

6.3 Cards Events Filter 

We can run different queries to get specific events records regarding different personnel, departments events etc. 

Similarly to 10.1 the View menu allows us to export the result to an MS-Excel file or previewing it in a printable 

mode. 
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6.4 All Hardware Events 

This report will display all the hardware events. In the View menu we will find the Filter to search and find certain 

records only such as the Locate Value for a certain value and select the Fields to be presented and Preview in a 

printable mode. 
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6.5 Face Recognition Records 

View Captured Face device records

 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

144  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

6.6 Bank Card Events – Displays all the bank card events on the software. 

 

6.7 Area Report 

In some cases we would like to know how many Personnel are in each area. The Area Report provides us with this 

kind of information. It has the same features in its View menu like the report above. Please note that Anti-Pass back 

feature must be active and used properly for the information in this report to be accurate. 
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6.8 Personnel Area Report 

Personnel Area Report allows for the viewing of Personnel currently in each area. It has the same features in its View 

menu like the reports above (Sections 10.1 – 10.3). Please note that Anti Pass back feature must be active and used 

properly for the information in this report to be accurate. Both this report and the Area Report (Section 10.4) can be 

used in emergency cases where security personnel would like to evacuate the building immediately. They can know 

where personnel are and whether all the areas are empty. 

  

6.9 Area Changed Report 

This report tracks how the Personnel are moving inside the buildings/offices from one area to the other. This can help 

to trace certain personnel and see where they were and at what time they were there. It has the same features in its 

View menu like the reports already described in Sections 10.4 - 10.5. Anti-Pass back must be activated and properly 

used. 

 

6.10 Personnel In/Out Reports – Consist of two types of reports. 

• Card Not Used Long time 

Displays Cards that are not used 
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• Personnel Not Out of Designated Area - To show report if personnel are not yet out of the building 
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6.11 Access Level Report 

Access Level Report displays all the personnel’s access level. It has the same features in its View menu like the report 

below. 
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6.12 Access Security Group Report 

Access Security Group Report displays all personnel’s access levels via security groups. 

 

6.13 Time Attendance 

The System displays an attendance report in accordance with the condition such as personnel, department, and 

record type. The condition is described via the follow illustration. 
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6.14 Time Canteens Report 

Times Canteen report is consisting of different types of reports.

 

6.15 All Intrusion Events 

This report displays all different reports from intrusion panels. 
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6.16 All Intrusion system status 

This report displays all the status of the zones for the intrusion. 

6.17 All CCTV Event 

The System displays all the events relating to CCTV. It has the same features in its View menu like the report below.  

  

6.18 All Alert Events 

The system displays all types of alert events such as card events, controller operation events, CCTV events. We can 

find out problems by checking the events. It has the same features in its View menu like the report above (Sections 

10.1 – 10.3). 
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6.19 Alert Events Filter 

We can run different queries to get specific alert events records regarding different system, record type, events etc. 

Similarly to 9.1 the View menu allows us to export the result to an MS-Excel file or previewing it in a printable mode. 

  

  

6.20 System Log 

The System Log displays which WatchNET Access Software user has logged on and when. It shows what kinds of 

actions were taken by the user. This way we can easily know who was the Guard or Operator of the system during a 

certain time. In case we would like to investigate a critical event like intrusion to the office or building the System Log 
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will allow seeing In whose shift it happened. . It has the same features in its View menu like the report above 

(Sections 10.1 – 10.3). 

 

  

Chapter 7 Maintenance 

7.1 Delete Records 

Delete option can be setup as scheduled or delete all at once, this help saved more storage for database. 
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7.2 Backup Database 

The user should backup the Database after any programming or Personnel changes so that the data can be restored if 

required. Select Backup Database from the Maintenance.  
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Disconnect any clients that may be accessing the database Select a location to save the Database (Zip format) and 

then select OK.  

 

Then click the Backup button to continue. 

.  

If the Database was backed up successfully the Database backup successful message below will display. Click OK. 

7.3 Auto Backup Database 

Similar to 10.3 we perform a scheduled database backup.  
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7.4 Restore Database 

If the Database needs to be restored select Restore Database from the Maintenance menu. The restore needs full 

access to the database and if some other programs are using the database, the Database Restore option may not 

work. Disconnect any clients that may be using the database before restoring. Select the database that you wish to 

restore and click on Restore.  

 

Before restoring a warning message will be displayed warning that the existed database will be overwritten and lost. 
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Once the database has been restored the software will need to be restarted. Click OK to restart. 

 

7.5 Compact/Repair Database 

The Compact/Repair feature will repair and compact the database. 

 

A warning message will be displayed. Click on YES to continue.   
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7.6 Auto Compact/Repair Database 

Allows you to set a date or time when the auto repair starts 

 

Chapter 8 Tools 

8.1 External Tools 

Allows users to have External Icons of third party software to be imported into the WatchNET Access Software and to 

open the applications conveniently from within the software window.  

  

To add an External Tool, follow the steps below: 

1. Click Add to open the following window. 
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2. Amend the default title. 

3. Click the Command  button to select a tool. 

4. Enter the parameters in the Parameters text field. 

5. Enter the value of the Directory. 

6. Click OK or Apply to finish adding the tool. 

8.2 Imports from Excel 

WatchNET Access Software allows the user to import data from an Excel file. The data can be taken from 3rd party 

software like TIME AND ATTENDANCE software, Human Resources software or any list of data. 

The data which can be imported are Personnel ID, First Name, Last Name, Identity, Gender, Card Number and 

Departments. Before you proceed with importing, it’s highly recommended to back up the current WatchNET Access 

Software Database. Select Tools -> Import from Excel and the window will be opened. 

Inside the WatchNET Access Software folder there is a folder named “Template” which has a MS-Excel Template file 

named Personnel.xlt.  
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Open the file and enter the information you would like to import to the WatchNET Access Software. Save the file as 

Excel 97-2003 Workbook.  
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Note: “Card Sector” is the Site Code and “Card Offset” is the card number. For example is the card 

number is 226 ,03138 then in the “Card Sector” column input 226 and in the “Card Offset” input 03138. 

 

To start importing select Tools -> Import from Excel. 

 

The Import Wizard window will be displayed. 
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Read the comments carefully and click on Next. 

 

Read the comments carefully. Inside WatchNET Access Software folder there is a folder named Template which has 

an MS-Excel Template file named Personnel.xlt. Open the file and enter the information you would like to import to 

WatchNET Access Software. Save the file as an Excel 97-2003 Workbook. 

 

Click Next to continue. 
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Click OK and the window in will be displayed. 

 

Click OK and Cancel to exit the Import Wizard. Verify that WatchNET Access Software has all of the imported the 

data.  

8.3 Export Events Automatically 

WatchNET Access Integrated Security Systems provides a powerful module which can run separately and exports all 

card events. The exporting is performed by creating Tasks. 

Each task creates a different export file with info that users define. Click on Tools -> Export Events Automatically to 

launch the window. 
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• Name: Exporting task name. 

• Enable: Tasks is saved and enabled, running or scheduled to be running. 

• Runnable: Task was already executed in the past. 

• Executed: A task already performed. 

• Status: Status of the task. 

• Last Export: When was the last time the task was performing exporting. 

• Next Export: When is the next time the task will perform exporting. 

New Task 

When clicking the New Task button, the window will be displayed.  

 

Click Next. The window will be displayed. 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

164  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

 

Select the data type you wish to export and click Next. Select the Personnel you wish to export and click Next. 

 

Select the Departments, Sub Departments, Time Period, Doors, Record Type to export all relevant records and click 

Next. The window will be displayed. 
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Select the Fields to be exported (or all fields). For each selected Field the format can be set according to user’s 

needs.  

 

 

http://www.watchnetinc.com/
http://www.watchnetaccess.com/


         

 

 

 

166  P a g e                                                           
351 Ferrier Street • Markham, ON • L3R 5Z2 

PHONE: 416-410-6865 TOLL FREE: 1-866-331-3341 • FAX: 905-752-0186 
www.watchnetinc.com / www.watchnetaccess.com  

 

 

 

Check the Title will be the 1st line if you would like the fields name to be the first line in the file before the events. 

Enter the folder path and select the file format (MS-Excel, TXT, RTF, HTML etc.). Select the separator to separate 

between the different fields which were selected in Figure 11-5. Enter the File name and click Next. The window in 

Figure 11-6 will be opened. 

 

When you click on OK the following window for task successfully created will be displayed. 

 

User can decide if the task should run immediately or be scheduled for later. Set the Task Name and Enable it. Set 
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the Frequency to be Daily/Weekly/Monthly. Set the Daily Frequency to be one time or periodically (as frequent as 

every minute). Keep Time will set if we limit the period of exporting to certain dates or infinite. Click OK and the 

window will be displayed. 

 

Delete Task 

Delete the selected task. 

Edit Task 

Allows the user to edit the task details, as in Section 11.3.1. 

8.4 Capture Tool 

WatchNET Access Software allows taking pictures of Personnel or Visitors using a web camera or Digital camera. Click 

on Tools-> Capture Tool to launch the window in Figure 11-34. User can take photos which will be stored in the Photo 

folder inside the folder of WATCHNET ACCESS INTEGRATED SECURITY SYSTEMS. User can also setup the camera and 

adjust its parameters. 

Before you can use this feature, make sure that the camera is connected to the PC and camera driver is already 

installed and operating. 

  
Click the Capture button to capturing the image and click Close. 
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8.5 Card Printer 

Card Printer option allows you to print badges for the card; user can create their own template to print. 

Note: Printer must be installed first before running this feature 

 

8.6 Run as Task Scheduler once Windows start 

Input username and password for the windows so that software will start when the computer reboots. 
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Chapter 9 Window 

9.1 Save Desktop 

You can save your desktop layout as a template through this command. 

  

 

9.2 Delete Desktop 

You can also delete unwanted desktop layout by clicking on the appropriate one and clicking on OK.  

  

9.3 Screen Style 

WatchNET Access Software provides you with an option to view the Window in the following styles: Standard Style, 

NET Style, Office Style, and XP Style. 
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If you need to see captions on all the Icons then you can check the Show Caption option. 

Chapter 10 Help 

10.1 Help 

Clicking on Help will launch the WatchNET Access Control Software Manual. 

10.2 Home Page 

Launches the WatchNET Access Control Website. 

10.3 On-line Update 

Coming soon 

10.4 License Information 

Will display the information of the Registration Information of this WatchNET Access Software.  

 

10.5 Upgrade License 

It is important to Re-Register the end user so the Legal User will display at the bottom of the main window. Accurate 

and updated Legal User is needed for verifying that the WATCHNET ACCESS INTEGRATED SECURITY SYSTEMS is 

genuine and a legal copy.  

  

It is also needed for upgrading the WatchNET Access Software license. The user can upgrade the software license to 

control more doors, more clients PCs, have additional modules like CCTV, Intrusion etc. For upgrading the WatchNET 

Access Software license the user needs to provide WatchNET Access information such as the USB dongle serial 
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number and the Legal User name as seen in Help -> Registration Information.  

In the case above Serial Number is 00000005 and the Legal User is WATCHNET ACCESS. WatchNET Access will provide 

a Registration Code in a TXT format. Click Help -> Re-Register and search for the file client.txt that’s provided by 

WatchNET Access (Figure 13-3). Clicking OK will upgrade the WatchNET Access Software license to the needed license 

while keeping the existing USB Dongle. 

  

10.6 About 

About window lists the software details such as the Version number and the last build time plus WATCHNET ACCESS 

contact details. 
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